
 

Form Builder Reference Guide 2013 v 0128 Page i 

 

2011 v 0510 2013 v 0128 

Form Builder 
Reference Guide 



 

Form Builder Reference Guide 2013 v 0128 Page i 

Contents  

♦ Login/out process – see the Client Reference Guide .......................................................... 1 

♦ How to access an existing form ........................................................................................... 1 

♦ How to work with an existing form ....................................................................................... 1 

♦ How to add a new form ........................................................................................................ 2 

♦ How to start building a form ................................................................................................. 3 

♦ How to use the toolbar at top of screen ............................................................................... 4 

♦ How to define parameters for the parent category container ............................................... 4 

♦ How to add a child category container................................................................................. 5 

♦ How to define questions in a child category ........................................................................ 7 

♦ Autopopulated diagnosis dropdowns when mapping ........................................................ 15 

♦ How to define answers ...................................................................................................... 15 

♦ How to test a form ............................................................................................................. 17 

♦ Handheld/tablet considerations ......................................................................................... 18 

♦ Web forms and templates .................................................................................................. 19 

Step 1. Build the Form Export....................................................................................................................... 20 
Step 2. Edit the Field Names in the PDF ...................................................................................................... 22 
Step 3. Add Signature Fields to the PDF ...................................................................................................... 24 
Step 4. Upload the PDF template into Credible............................................................................................ 24 



 

Form Builder Reference Guide 2013 v 0128 Page 1 

♦ Login/out process – see the Client Reference Guide 

♦ How to access an existing form 
1. Click the ‘Forms’ tab. 

2. Search for the form using specific criteria: 

• Form ID – auto generated when a new form is added. 
• Program – select from list provided. 
• Visit Type – select from list provided; shows the form linked with the selected visit type. 
• All Form Types – default shows all forms or you can select ‘Employee Forms’ or ‘Client 

Forms’ to show only those forms built for employee services or client visits. 
• Form Name – name given to the form by the user when it was added. 

• Built Since – select from list provided to see forms built within a specific timeframe. 

• Phy Orders – select ‘With Phy Orders’ to show only forms associated with physician 
orders or ‘W/O Phy Orders’ to show only forms that are not associated with physician 
orders. 

• Intake – select ‘With Intake’ to show only forms associated with the Intake nav bar or ‘W/O 
Intake’ to show only forms that are not associated with the Intake nav bar. 

3. Click ‘Filter’. 

4. Use page and arrow navigation buttons at the bottom of the screen to move through pages. 

♦ How to work with an existing form 

• Click ‘view’ to view the configuration of the form without being able to edit it. 

• Click ‘copy’ to copy an existing form to your production system or test system. When used in 
conjunction with the Provider Portal Agreements function, you can also use copy to share 
forms with another Credible Partner. See the online help for more information. 
Notes: 
You must click ‘new version’ and then ‘build’ and ‘activate’ for the form after it is copied. The 
form will not work properly until it has been rebuilt and activated. 

If the form has questions with the Calculated Field answer format, you have to individually 
save each question once the form is in the copied location. 

• Click ‘new version’ to begin a new version of the same form while the old version remains 
active. 

– The old version moves down a row and all the parameters defined in it are copied forward. 

– ‘edit’ and ‘build’ buttons replace the ‘new version’ button. 

– Once the new version is built and activated (status = Active), the old version is removed 
and the ‘new version’ button replaces the ‘edit’, ‘build’, and ‘activate’ buttons. 
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• Click ‘edit’ to make changes to an existing form before it becomes active. 

– The ‘edit’ button is available when status = In Progress. 

– If you need to change a form due to new regulations, click ‘edit’, make the desired 
changes, then build and activate. 

– Once status = Active, the old version is no longer available for use. While new visits will 
use the new form, incomplete or completed visits will display the version of the form that 
was active when the visit was started. 

• Click ‘build’ when you are ready to make a form active. After you click ‘build,’ the form receives 
a build date and time and an ‘activate’ button is added. 

• Click ‘activate’ to provide this form to staff for entry. 

• Click ‘red X’ to delete a form. Note: you should not delete a form in use until a replacement 
form has been identified. 

♦ How to add a new form 
1. Click the ‘Forms’ tab and scroll down to the Add Form box at the bottom of the screen. 

2. In the Form Name field, enter the name of the form (25-character max). 

• We recommend using a convention that helps identify forms that are not yet in use. For 
example, precede the name with an underscore. 

• You may also want to include a prefix that identifies the name of your organization in case 
your forms become part of the Credible Library. For example, ‘CW_Med Progress Note’. 

Note: you can edit a form name at any time without affecting data entry. 

3. Use the Visit Type dropdown/field to specify the visit type the form will be linked to. 

• To use an existing visit type that doesn’t currently have a form linked to it, select one from 
the dropdown. 

• To create a new visit type, enter its name in the field (20-character max). The system will 
auto create the visit type and link the form to it. If the new form is going to replace a form 
linked to an existing visit type, enter a temporary visit type name. When you are ready to 
test the form, you can delete the newly created visit type and manually link it to an existing 
visit type. 

4. From the Form Type dropdown, select Client or Employee to indicate whether clients or 
employees will use the form. Note: once the form type is selected, it cannot be changed. 

5. Click ‘Add Form’. The form is added to the forms list; the status = In Progress and the ‘edit’ and 
‘build’ buttons are available. 
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♦ How to start building a form 
1. Click ‘edit’ for the form you added. This brings up the Form level view. 

2. Define the parameters for the form: 

• Form ID – auto assigned and cannot be changed. If a form is deleted, the deleted ID will 
not be reused. 

• Form Name – 25-character max. You can edit a form name at any time without 
ramifications. 

• Employee Form – checkbox will be selected if you indicated the form is an employee form 
when you added it. 

• Show Physician Orders – select if the form should provide access to the Physicians 
Orders screen. 

– Note: if selected and if the user conducting the visit has the PhysicianOrdersView 
right, there will be a Physicians Orders link below the Billing Info/Sign & Submit link. 
Clicking the link displays the Physicians Orders screen for the client. 

– The user can add a new order and manage existing orders if he or she has the 
appropriate security rights.  

• Show Intake Nav Bar – select if the form should provide access to the Intake nav bar. The 
Intake nav bar contains a subset of the functions on the Client nav bar. 

– Note: if selected, there will be a Client Intake link below the Billing Info/Sign & Submit 
link. Clicking the link displays the Intake nav bar (in image only mode) and the screen 
that corresponds to the first function in the nav bar. The Intake nav bar does not 
display in Credible Mobile. 

– To select the functions for the Intake nav bar and control their order: Admin tab > 
Home Page Config > Client Navigation.  

• Is Incident Form – select if you need to restrict access to the completed visit to users with 
the ViewIncidentForm right. If selected and the user doesn’t have the right, the visit will not 
display in Client Visit List (Visit tab). An incident form typically contains sensitive data. 

• Category and Answer Popup Notes Size – default is 500 and allowable range is 250 – 
5,000. Setting controls the size of the note boxes associated with child categories and 
answers. 

• Version Number – auto assigned and cannot be changed. 

• Build Date – auto generated when you click ‘build’; build date cannot be changed. 

• Active Version Number – auto assigned when you click ‘activate’. 

• Active Build Date – auto assigned when you click ‘activate’. 

3. Click ‘Update Form’. 
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♦ How to use the toolbar at top of screen 
• Arrow – brings you back to the Form List whereby only the current form being worked on is 

displayed. 

• Copy – lets you copy the category or field you are currently on. Note: you can copy and paste 
the same category or question repeatedly by continuing to click the Paste icon when on the 
parent category or a child category. However, you can only copy and paste a form once 
without going back to the same form and repeating the copy process. 

• Cut – lets you cut the current category information and paste it elsewhere.  

• Paste – lets you paste what was copied.  

• Delete – lets you delete the item you are currently on. Note: you cannot delete a category until 
all children/questions are deleted.  

• Preview – displays the form as it will appear when used during a visit.  
You cannot copy, cut, paste, delete, or preview the form at Form level. 

Note: in Form Builder, there is no ‘undo’ for any editing action. 

♦ How to define parameters for the parent category container 
When you add a form, the system automatically creates the initial or parent category container. 
When viewing the “tree structure” of a form, it is indented from the form name and has the default 
name START [FORM NAME]. 

1. Click the ‘START [FORM NAME]’ link in the tree view. This brings up the Category Container 
view. 

• Category Name – 25-character max; label for button to start visit/access the form when 
using Credible Mobile. We recommend keeping it the same as the form name. Note: if 
using MobileForm (first generation Credible Mobile), you should keep the category name 
short due to pixel differences between letters (for example, w and m are larger than i) and 
the restricted view in MobileForm. 

• Description – 50-character max; does not show anywhere except in Form Builder. 

• Order – if there will be multiple category containers, select a number to indicate the order 
of the category. You can change the order once more category containers are defined. 

• Navigation Type – the default of none (…) and the Menu option both provide a tree format 
and let users move freely between category containers. The Page Order option forces 
users within a category to go through page 1, page 2, and so on before moving to the next 
category container. Do not select unless going in the same order is essential for form use. 

• Page Break Before Category – for printing the form (does not affect the visit view); select 
YES if the category container and all subcategories should print on separate pages. Page 
breaks are only supported if your system prints visit details in the default HTML format. 
Note that the header and signatures will also be on separate pages. If your system prints 
visit details in PDF and page breaks are essential, you can create a template for the form. 

2. If you make any changes, click ‘Save Category’. If you changed the category name, the new 
name is reflected in the tree view. 
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♦ How to add a child category container 
A child category container/screen is a subsection of the parent category container. Child 
categories are useful for where natural breaks occur in a form (for example, where a signature is 
needed). Once a category container contains questions, it is called a category screen. If using 
mobile devices, the limit should be 8 child categories per form. If using a tablet, you can have up 
to 15 child categories per form. 

1. Click ‘Add Child Category’ to begin designing the form. 

2. Define the parameters for a child category: 

• Category Name – 25-character max 

• Description – 50-character max; does not show anywhere except in Form Builder 

• Order – if there will be multiple child categories, select a number to indicate the order of 
the child category. You can change the order once more child categories are defined. 

• Navigation Type – click here for a description. Note: the field is only visible if the child 
category contains subcategories and does not have specific questions related. 

• Has Notes – puts a notes box at the end of the category. Only select if it is necessary for 
users to enter notes specific to a category. 

• Page Break Before Category – for printing the form (does not affect the visit view); select 
YES if child category and all subcategories should start printing on separate pages. 

• Embedded Signatures – adds signature boxes to the end of the category below the 
‘Complete’ button. Applicable for an integrated assessment that includes categories 
(sections) specific to different disciplines or a form that requires a client to sign a section 
within the form.  

– You can use an embedded signature when a form (for example, a consent form) 
includes a statement that needs the client signature just after the statement. The 
statement would be a label at the end of the form category and the category would be 
configured to include the embedded signature so the signature displays just after the 
statement. 

– Embedded signatures are completed with a signature pad or tablet PC (not with a 
password). This feature works with a mobile laptop or handheld if the device is a tablet 
PC or has ability to sign with a mouse. 

– You can include up to 16 signatures within a form associated with the entire visit. 

– You can include up to 4 signatures in each category (the default is 0). Signature boxes 
do not display when previewing the form. 

– If you enter a number other than 0, the appropriate number of signature boxes will 
appear at the end of the category below the ‘Complete’ button. Note that you must 
have ‘Signature Pad’ or ‘Tablet Signature’ selected in your Employee Config to see 
embedded signature boxes in a form. Also, embedded signature boxes will not display 
until a form is activated and applied to a service. 
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– Regardless of whether a form has embedded signatures, the employee associated 
with the visit must sign it electronically using the standard Billing Info/Sign & Submit 
process. 

– Once a signature is entered, the user needs to click the ‘Complete’ button for the 
category to save it. The signature cannot be changed once ‘Complete’ is clicked. 
Saved signatures are displayed below the form section in the Visit Details screen if the 
Show Visit View Signatures setting in Partner Config is selected. 

– Individuals who need to complete an embedded signature can sign during the visit or 
before or after it is signed and submitted. 

If visit was started but not 
completed 

If visit has been signed/submitted 

Form access is through original 
provider’s incomplete visits list. 

Form access is through Visit Details screen (‘Edit Full 
Visit’; user needs ClientVisitUpdateForm right). After 
signing and completing, Visit Details screen redisplays. 

– If your system is set up to print visit details in PDF, the signatures will be included in 
the PDF print view after all the form data, either at the end of the document or on its 
own page. They are not embedded in the form data as they are in the HTML version. 

• Tx Plus – sets up the form to be a Tx Plus form. You use forms exclusively to document 
against a Tx Plus plan. A Tx Plus form can have a single category flagged for Tx Plus or 
can have multiple categories with one of them being a Tx Plus category (for example, a 
Progress Note). Note that you cannot add a child category or questions to a Tx Plus 
category. 

3. Click ‘Add Category’. The tree view displays the child category name indented from parent 
category container. 

4. To add another child category at the same level as your initial child category, click ‘Add Child 
Category’ when you are on the parent category container in the tree view. 

Note: if necessary, you can add a subcategory to a child category. However, you can only do 
this if you haven’t added questions to the child category. That is, once a child category 
container becomes a child category screen, the ‘Add Child Category’ button is no longer 
available. In the tree view, a subcategory is indented from its child category. 
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♦ How to define questions in a child category 
1. Click a child category container in the tree view.  

2. Click ’Add New Question’. This brings up the Question view. Note: you can define up to 128 
questions in a category or up to 80 questions if the form will be used on a mobile device. While 
you can add more than 128 questions to a category if you are copying and pasting them, we 
recommend keeping the number low for speed purposes. 

• Question – 120-character max (approximately). Label Only questions have a 
4,000-character max. Click ‘ABC’ to check spelling. 

• Answer Format – select from list provided. Depending on selection, the Advanced Options 
may change and a Question Details section may display. All injected data is read-only. 

Answer Format Description 

Calculated Field Provides a text box in the Question Details section for a formula to 
perform simple arithmetic (add, subtract, multiply, and/or divide). In 
the formula, you can use Numeric Push Button questions, Numeric 
Text Box questions, and other Calculated Field questions that are in 
the same category. A calculated field is useful if you have multiple 
“rating” questions and you need to total all the ratings and/or perform 
a calculation based on the total. 

1. Click ‘Update Calculation’. 

2. From the Question box, select the questions you want to use in 
the calculation by double clicking them. You can also manually 
enter a question identifier (for example, Q1) in the Question 
Calculation field. 

3. Double click the appropriate operator or enter it next to the 
respective question without inserting a space. 

4. If separators (parentheses) are necessary for the calculation, 
include them next to the respective question or operator. 
Separators are used to change the order of operations: 5+3*8 = 
64 while 5+(3*8) = 29. The system performs the operation in the 
parentheses first and then goes from left to right. 

Calendar Control Provides a date-validated text box with a calendar popup icon. Using 
the fields in the Question Details section, you can specify a range for 
valid entries and/or a default date. Enter a specific date or 
GETDATE() for the current date. To specify a certain number of days 
from the current date, enter a plus or minus sign and the appropriate 
number in the parentheses. 
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Answer Format Description 

Checkbox Provides vertically aligned checkboxes with labels. Multiple answers 
can be selected. Used for most checkboxes on forms. The question 
is typically the label that defines the checkboxes and the answers are 
the labels for checkboxes.  

Dropdown Provides standard dropdown that lists the answers. Only one answer 
can be selected. Width of dropdown box adjusts to longest answer. 

Full Injected Diagnosis Provides all Axis I-V diagnoses and Axis IV stressors from the active 
assessment. The injected data includes the Effective Date and the 
information in the Notes section for each diagnosis. When this 
answer format is used, a Switch button will be available so the 
employee filling out the form can change the assessment that is 
injected into the form.  

Injected Admin Time 
entries for the past week 

For an employee form – provides the time entered into the Admin 
Time screen for the week prior to when the injection is occurring. 

Injected Allergies Provides data from the Client Allergies screen. 

Injected Billable Service 
time for past week 

For an employee form – lists services identified as billable for the 
week prior to when the injection is occurring. 

Injected Client External 
Providers 

Provides data from the External Care Providers screen. 

Injected Contacts Provides data from the Contacts screen. 

Injected Data Dictionary 
Field 

Provides a single value from one of the following tables: Client 
Episode, Clients (client profile), or Client Extended.  

Injected Diagnosis Provides the Date Created and a subset of the active assessment: 
the first three Axis I diagnoses, both Axis II diagnoses, the first two 
Axis III diagnoses, Axis IV notes, and the Axis V score. Notes from 
the Axis I-III diagnoses and the Axis IV stressors are not included. 

Injected Family Provides data from the Family screen. 

Injected Lab Results Injects lab results that were entered manually into a client’s record or 
imported automatically through Credible eLabs. 

Injected Medical Profile 
Details 

Provides the data from the lower section of the Medical Profile 
screen. 
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Answer Format Description 

Injected Medical Profile 
Header 

Provides the data from the upper section of the Medical Profile 
screen. 

Injected Medications Provides the name, start date, dosage, and frequency for each 
medication and prescription in the Medications screen. 

Injected Medications Full Provides additional details (for example, instructions and quantity) for 
each medication and prescription in the Medications screen. 

Injected Medications Full 
eRx Only 

Restricts injected medications to the active prescriptions created 
through Credible eRx. Full details about each medication are 
injected. 

Injected Non-Billable 
Service time for past week 

For an employee form – lists services identified as non-billable for the 
week prior to when the injection is occurring. 

Injected Time Sheet 
entries for the past week 

For an employee form – provides the time entered into the work 
schedule for the week prior to when the injection is occurring.  

Injected Tx Plan Provides the client treatment plans for the treatment category you 
specify. 

Injected week start/end for 
TimeSheet 

For an employee form – provides the dates for the week prior to when 
the injection is occurring. The week runs from Sunday to Saturday. 

Label Only Lets you enter read-only text for instructions or a topic header for a 
group of questions (4,000-character max). Note: do not select 
Category Required or Form Required for a Label Only question as 
there is no way for the user to answer it. 

Numeric Drop Down Lets you incorporate the answer to a dropdown in a calculated field. 
The answer must be numeric (the system validates it) and if long text 
is present for an option, it will be displayed in the dropdown. If you set 
the question up for mapping, the system will map the answer value 
(vs the long text). 

Notes: 

• If you have multiple numeric dropdowns in a form, only one 
can map 

• Numeric dropdown answer format is not currently available 
in Credible Mobile 
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Answer Format Description 

No Label Checkbox Provides horizontally aligned checkboxes without labels. Multiple 
answers can be selected. Used mostly as a prompt to open a text box 
with a spell checker – the question has one answer with the Has 
Notes setting = YES (text entry can be 500 characters or more). For a 
checkbox to appear, the Answer field needs to contain at least one 
character. 

No Label Radio Button Provides horizontally aligned “radio buttons” without labels. While 
these have the appearance of checkboxes, they are considered radio 
buttons because only one answer can be selected. For a radio button 
to appear, the Answer field needs to contain at least one character. 

Numeric Push Button Provides horizontally aligned push buttons with numeric labels; 
decimals are allowed. Only one answer can be selected. Can be part 
of a calculated field. 

Numeric Text Box Provides a numeric-validated text box. You can specify a range for 
valid entries and/or a default answer. Can be part of a calculated 
field. 

Push Button Provides horizontally aligned push buttons with single-letter labels 
(only first character of answer will display). Only one answer can be 
selected.  

Radio Button Provides vertically aligned radio buttons with labels. Only one answer 
can be selected. 

Text Box Provides a standard text box (500-character max; default is 35 
characters and single-line format). Default Answer box has a 
250-character max. 

Time Provides a time-validated text box with a clock popup icon. A valid 
time format of HH:MM, H a, H p, or H is required. AM or PM is 
optional. 

• Order – if there will be multiple questions in the category, select a number to indicate the 
order of question. You can change the order once more questions are defined. 

• Category Required – select True if you want the question to be required for category 
completion. Note that you should never make an injection-type question required. 
Category-required questions are identified with a red asterisk. When the user accesses 
the category during the visit, he or she cannot complete it until an answer is provided. 
Note: if the category is not accessed, an answer will not be required. To make a question 
required regardless of whether the category is accessed, use the Form Required setting 
below. 
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• Form Required – select True if you want the question to be required for form completion. 
Form-required fields are identified with a red asterisk. If the user completes the form 
without answering all the form-required questions, the system identifies the questions that 
need to be filled out on the Billing Info/Sign & Submit screen. 

• Include in Summary – select True if you want to include the question and the answer 
supplied when the form is filled out in the clinical summary for a visit. For Meaningful Use, 
you must include injected diagnoses, medications, and allergies. To be able to view the 
summary (in the Visit Details screen and Client Portal), you need to select the Include 
Summary checkbox in Visit Type config. Refer to the online help for the steps to set up a 
clinical summary. 

• External Code – sets up the question so it can be used in an export (used for certain state 
reports). 

• Trigger Notification – for Calendar Control; select True if you want to create a notification 
based on the date entered during the visit. 

• Advanced Options – use these settings to format the question and answers and make the 
question conditional. If the answer can be mapped back to a client record, there will be a 
Field Map dropdown. The defaults vary based on the answer format. 

Advanced Option Description 

Control Align Select Left or Right to control whether the answer field (for example, the 
checkbox) is to the left or right of the label. Only applicable for certain 
answer formats. 

Line Break Select True if you want the question label and answer field on different 
lines. Select False if they should be on the same line. 

Label Position Identify the number of pixels the question label should display from the 
right side of the spiral binding when using the form during a visit. Note: if 
Line Break = False, you need at least 6 spaces between the Label Position 
and Control Position. 

Control Position Identify the number of pixels the answer field should display from the right 
side of spiral binding when using form during a visit. 

After Spacing Specify the amount of white space you want between an answer and the 
next question. 

After Line Select True if a solid line should display between questions.  

Label Bold Select True if the question label should display as bold. 

Label Large Select True if question label should display in a larger font size. 
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Advanced Option Description 

Can Be Hidden and 
Is Hidden 

Set up a question so that it is displayed or hidden until a condition is met 
that hides or shows it. After setting up a show/hide question, you need to 
set up the condition – an answer to another question – that controls 
whether the show/hide question is hidden or shown. 

 Can Be Hidden Is Hidden 

Always display the question False False 

Display the question until a 
condition is met that hides it 

True False 

Hide the question until a 
condition is met that displays it 

True True 

Notes: 

• Conditional show/hide functionality only works within the same child 
category and the maximum number of questions that you can 
show/hide in a child category is 19. The functionality is only 
recommended for checkboxes, radio buttons, and push buttons; it 
is not available for the Dropdown answer format. Conditional 
show/hide functionality is not currently available for handheld 
devices. 

• Do not specify a default answer for a show/hide question. If you do, 
the question and default answer will be included in the 
documentation for the completed visit even if the condition is not 
met. 

• The visit type setting Show All Questions applies to show/hide 
questions – that is, they will be included in the documentation for a 
completed visit even if they are not answered. 

The conditional show/hide functionality works as follows: a question has 
answers whereby other questions should show or hide based on one or 
more of the answers to the question. This question should always display 
so Can Be Hidden = False and Is Hidden = False. One or more of the 
answers for this question have specific questions in the Show/Hide 
Questions box selected. 

• Questions that will be hidden based on the answer selected for the 
original question have Can Be Hidden = True and Is Hidden = 
False. 

• Questions that will display based on an answer selected for the 
original question have Can Be Hidden = True and Is Hidden = True. 

Any question in the child category that has Can Be Hidden = True will 
display in the Show/Hide Questions box. 
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Advanced Option Description 

Field Map Identify the field in the client record that should be updated with the answer 
after the user signs and submits the form. Each field is preceded by the 
table it is in. Any fields you add to the Clients (client profile), Clients Ext, or 
Client Episode tables through Data Dictionary will display in the dropdown. 
You can map all answer formats except for injection types and Label Only. 

Note: for mapping to be successful, there must be an exact match 
between the data type of the answer entered and the field you are mapping 
to. 

• If you are mapping to a date field (for example, DOB in the Clients 
table), the answer must be a date. To ensure the correct data type, 
select Calendar Control as the answer format. 

• If you are mapping to a numeric field (for example Quantity in the 
Meds table), select Numeric Push Button or Numeric Text Box. 

• If it is a Boolean field (for example, Gender), make sure the 
appropriate single-character answers are available. 

• If it is a dropdown (Is Lookup = Yes) and the lookup_ID or 
lookup_code is used for the External ID in Data Dictionary, you 
need to enter the ID or code that corresponds to the answer in the 
External Code field in the Answer screen. 

Note: if you are mapping to the Contacts table, you need to add a Contact 
Type question before the Contact Name question. Select Dropdown as the 
answer format and make sure the answers you add match the contact 
types set up via the Contact Types function on the Admin tab. You also 
need to select the same Field Map Group number for each question that 
will make up a single contact record. 

In addition, the length of the answer must not exceed the maximum length 
of the field. You can control the answer length with the Calendar Control, 
Numeric Text Box, Text Box, and Time answer formats with the Textbox 
Width (Px) field. 

Use Data Dictionary to determine the data type and max length of the 
different fields in a client record. 
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Advanced Option Description 

Field Map Group Group together the multiple questions/fields associated with one contact or 
medication record. This is necessary because a client can have multiple 
contacts or meds. Note: this field only displays when the field you are 
mapping to is in the Contacts or Medications table. 

For example, assume three fields make up a med record: Medication 
Name, Dosage, and Frequency. For Med #1, you add three questions to 
correspond to the three fields and use Field Map Group 1 for each one. For 
Med #2, you add 3 more questions and select 2 from the Field Map Group 
dropdown for each one. By selecting the same Field Map Group number 
for each question in a “record set,” the system can associate the data 
entered during a visit with one med (or contact). 

In addition to the above settings, you can copy bullets from Word (for example, to assist in 
offsetting labels) and format question text with HTML tags. For example, you can 
emphasize text with bold (<b>text</b>), italics (<i>text</i>), or underlining <u>text</u>). 
You can also change the font color with hexadecimal codes (<font 
color=”#FF0000”>text</font> changes the font color to red). Note that HTML formatting 
does not transfer to forms that are used in Credible Mobile. 

• Question Details – this section displays for Calculated Field, Calendar Control, Label 
Only, Numeric Text Box, Text Box, and Time; the fields vary based on the answer format. 

Question Detail Description 

Field Calculation Text box for a formula to perform simple arithmetic; for more information, 
see Calculated Field answer format. 

Start and End Range You can specify a range for valid entries when using Calendar Control and 
Numeric Text Box. 

Textbox Width (Px) Defines the size of the text box displayed for data entry (typically 6-7 pixels 
= 1 character). Default is 35 for Calendar Control and Numeric Text Box 
and 140 for Text Box. For successful mapping, the text box width should 
match the maximum length of the field you are mapping to. 

Default Answer Lets you enter a default answer for the question; users can change the 
default during data entry. Do not specify a default answer for a show/hide 
question. If you do, the question and default answer will be included in the 
documentation for the completed visit even if the condition is not met. 



 

Form Builder Reference Guide 2013 v 0128 Page 15 

Question Detail Description 

Print Label For Label Only – select if you want to include the instructions/topic header 
in the completed form when viewed in the Form section of the Visit Details 
screen. 

Max Length For Text Box – identifies maximum length of data (including spaces) that a 
user can enter during a visit. 500-character max; default is 35. 

Multi Line If a large amount of data will be entered into the text box during the visit, 
make it a multi-line field by specifying 2 or more lines. Text box will have a 
scroll bar. 

3. After filling out the Question screen, click ‘Add Question’. The question is added to the tree 
view with a green question mark icon. 

4. To add additional questions to the same category, click ‘Add New Question’ in the Category 
screen. 

Note: if a category only has injection-type (read-only) questions and the user clicks 
‘Complete’, the injected data will be saved in the form but there won’t be a completion 
checkmark next to the category button. The user has to answer at least one question in the 
category for the checkmark to appear. If you want verification that a category was completed, 
you can add a category-required question with yes/no answers (for example, “Did you review 
the information displayed above with the client?”). 

♦ Autopopulated diagnosis dropdowns when mapping 
When you select a diagnosis field that corresponds to a diagnosis dropdown in the Multiaxial 
Assessment screen as the field map and you select Text Box as the answer format, the 
system will autopopulate the dropdown with the standard diagnoses. 

When you select an Axis IV stressor as the field map, the system automatically supplies the 
standard answers of Mild, Moderate, and Severe. 

♦ How to define answers 

1. Click the question in the tree view that you want to add answers to. 

2. Click ’Add New Answer’ (note that adding answers is not applicable for certain answer formats 
– for example, Text Box). The Answer screen displays. 

• Answer – 255-character max; however, only approximately 70 characters will display on 
screen (without needing to scroll horizontally) as wrapping of answer is not an option and 
box extends to size of longest dropdown option. Click ‘ABC’ to check spelling 
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• External Code – if the question is set to map to a dropdown (Is Lookup = Yes) and the 
lookup_ID or lookup_code is used for the External ID in Data Dictionary, enter the ID or 
code that corresponds to the answer (Admin tab > Custom Lookup Items). 

• Order – if there will be multiple answers per question, select respective number indicating 
order of answer. You can change the order once more ‘Answers’ are defined 

• Has Notes – puts a notes box at the end of the answer set when the answer is selected (for 
example, if you want users to enter a response to the answer ‘Other’). Note: for Checkbox 
or Radio Button, there will only be one notes box for all options collectively. For Dropdown, 
only one answer can have a notes box. 

• Is Default – select Yes if this answer should be provided as the default during data entry. 
Even if an answer is provided as a default, the end user can change. 

• Is Notification Trigger – select Yes if this answer should be available for Notification 
Trigger setup (Admin tab > Notification Triggers). 

• Long Text – if an Answer label is long, provide an abbreviation in the ‘Answer’ field and 
then provide details in this field. The long text answers are used when you view/print the 
completed visit. 

• Split Visit When Checked – for Checkbox and Radio Button question formats. If set to True 
for one of the answers and that answer is selected when the form is filled out, the visit will 
follow the same rules as one set to split at the visit type or Billing Matrix. The visit can only 
split once so if the visit type is set to split or another Split Visit When Checked question is 
answered, the visit will only split the first time. 
 
You need two Billing Matrix entries for the visit type the form is linked to -- a primary entry 
and one with Is Split Secondary selected. Add the appropriate CPT codes to each entry. 

• Show/Hide Questions – select the questions that you want to show or hide when this 
answer is selected. Questions that are in the same child category and have Can Be 
Hidden = True are included in the list. 

3. After filling out the Answer screen, click ‘Add Answer’. The answer is added to the tree view 
with a red pin icon. 

4. To add additional answers to the same category, click ‘Add New Answer’ in the Question 
screen. 
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♦ How to test a form 
To test a form, it must have a status of ‘Active’. 

1. Select Admin tab > Visit Type and then locate the visit type created when you added the form. 

• If the newly created visit type is not needed, delete it and then link the new form to an 
existing visit type. 

• If you are going to use the newly created visit type, edit the record and add a label 
(10-character max; the label displays in the Client Visit List). Define additional parameters 
as necessary. 

2. Select the Admin or Billing tab > Billing Matrix. 

• If you linked the form to an existing visit type, make sure there is a Billing Matrix entry for 
the visit type and note the program selected for the entry (use the Visit Type filtering field). 

• If are using the newly created visit type, you must define a Billing Matrix line. 

a. Click ‘Add New Entry’. The Billing Matrix Config screen displays. 

b. In the Entry Description field, enter a description of the Billing Matrix entry. 

c. In the CPT4 Code field, enter a ‘real’ CPT code or a placeholder if the Billing Matrix 
entry will be non-billable and therefore not submitted to payers. 

d. In the Start Minutes and End Minutes fields, enter the appropriate values. 1 and 1440 
are good for testing purposes; they indicate a visit can be billed minimally for 1 minute 
and up to 1440 minutes – this is good for assessments that are not time limited for 
billing. 

e. From the Visit Type dropdown, select the newly created visit type. 
f. From the Program dropdown, select the program that you want to associate with the 

visit type. Because the form is linked to the visit type, it will be indirectly associated 
with the program you select. 

g. In the Rate, Deaf Rate, and Fixed Units fields, enter the appropriate values. These can 
be any numeric value, they just cannot be empty. 

h. Click ‘Save Settings’. 

3. Assign a client and employee (preferably the person who is testing the form) to the program 
that is associated with the visit type (program/visit type linking happens in the Billing Matrix). 
Note: if the client and employee do not belong to the appropriate program, the program/visit 
type will not appear in the Visit Type dropdown when scheduling an appointment. 

4. Assign the client to the employee. 

5. Schedule an appointment for the employee, selecting the appropriate program/visit type from 
the Visit Type dropdown. Begin the visit to test the form. 
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♦ Handheld/tablet considerations 

Next Generation Credible Mobile MobileForm (first generation mobile): 

• Intake nav bar does not display in 
Credible Mobile. 

• Category container name is what users 
see in Credible Mobile (vs the form 
name). 

• Conditional questions are not 
supported – show/hide questions 
display regardless of whether the 
condition is met 

• Embedded signatures are not 
supported 

• Scroll bars are not visible. 

• Intake nav bar does not display in 
Credible Mobile. 

• Category container name is what users 
see in Credible Mobile (vs the form 
name). 

• Length of category name should be 
short due to pixel differences between 
letters (for example, w and m are larger 
than i) and the restricted view in 
MobileForm. 

• Maximum number of category 
containers that can display properly in a 
single form is 8 on a mobile device and 
15 on a tablet. 

• You should not exceed 8 child 
categories per category container and 
80 questions per child category. 

• Embedded signatures work with a 
mobile laptop or handheld if the device 
is a tablet PC or has ability to sign with a 
mouse. 

• Scroll bars are not visible. 

• Only the 10 most recent visits for each 
client will be available for display. 
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♦ Web forms and templates 
As you build a web form, you should consider whether users will need to print it out for external 
use after conducting a visit. If a completed form needs to be sent to an outside agency or external 
provider and printed out in a specific way, you can create a PDF template that corresponds to the 
web form. The template contains the answers/responses entered into the web form (as of data) 
and fields from tables related to the visit that you want to include (for example, the client’s current 
address or the employee’s NPI number). Because templates work off the form level and not the 
visit type level, you create one template per form – all visit types using that form will have access 
to the template. 
 
Before you can create a template, you need to build the web form and then build an export of the 
form “for template printout.” The only fields that can be brought over into a template are 
Dropdown, Calendar, Text, Numeric Text, Checkbox, and No Label Checkbox. Radio Buttons 
cannot be used for templates. Instead, No Label Checkboxes need to be used and each 
checkbox must be a separate question in the web form. 
 
The process to create a template is as follows: 

1. Build the web form (or copy it from the Library). 

2. Use word processing software to create an electronic version of the form (include your 
letterhead if appropriate). If you are using a form from the Library and it has an associated 
template that your Implementation Manager has sent to you, you can skip this step and the 
next step. 

3. Generate a PDF from the electronic version of the form (usually done with ‘Print to PDF’ or 
‘Save As a PDF’). The PDF must be saved locally. 

4. Use the Export Tool in Credible to build an export of the form for template printout. 
 
Once you have built the export, there will be a ‘Template’ button in the button row in the Visit 
Details screen for visits that used the form. Note that users won’t be able to print the form in 
template mode until you complete the steps below.  

5. Use the full version of Adobe Acrobat (or other PDF software; see 
http://en.wikipedia.org/wiki/List_of_PDF_software for a list) to edit the field names in the PDF 
so they correspond to the export names of the fields in the form. Having Acrobat automatically 
detect the “form fields” in the PDF will help speed up the editing process. If Acrobat misses a 
field during auto detection, you will have to add it. 

6. From the export list in Credible, upload the PDF. 

To view the PDF template in the Internet Explorer browser, a PDF ActiveX plug-in is needed. If a 
user is saving the template for viewing outside of the web browser, a PDF reader is needed. 
 

http://en.wikipedia.org/wiki/List_of_PDF_software�


 

Form Builder Reference Guide 2013 v 0128 Page 20 

 
Using a Table in a PDF Template 
 
If there will be a table in the PDF template and you want a specific answer to insert a 
checkmark in the appropriate cell of the table, you need to: 

1. Use a checkbox answer format (not a dropdown or radio button) for the question when 
building the form. 

2. Select the Expand Multi Choice checkbox when building the form export. 

3. Add checkboxes to each cell in the table in the PDF template.  

4. When matching the export column name (for example, Played cards for money) to the 
corresponding cell in the table in the PDF template, add “_#” after the column name (for 
example, Played cards for money_1, Played cards for money_2, and so on). 

Notes: 

• If there are checkboxes in the form and you want to include the checks in the correct 
checkboxes in the PDF template, the Export Name must be in the format of  
“answer_1”, “answer_2”, and so on and Expand Multi Choice has to be selected (in 
the Export Details screen). When you run the export, select the HTML format and the 
Header Row checkbox. 

• If you are using the no label check box answer format, do not select Expand Multi 
Choice in the Export Details screen. 

In the online help, refer to “Step 1. Build the Form Export” for an example of Expand Multi 
Choice. 
 

 

• Step 1. Build the Form Export 

The steps below assume that you have built the web form, created an electronic version of the 
form, and have a PDF of the paper form. 

Note: if the template is saved as separate PDF files, you need to ensure that all the fields from 
pages 1 and 2 are in one web form. Combine the two PDFs together by opening the 1st page 
PDF, selecting Document > Insert Pages > From File (Acrobat 9), and then selecting the 2nd 
page PDF. This will merge them into a single PDF. 
 

1. Click ‘Reports’ tab > ‘Export Tool’. 

2. In the ‘Export Name’ field at the bottom of the screen, enter a name for your template. 

3. From the Form/Table Name dropdown, select the web form and click ‘New Export’. The 
Export Builder screen displays. 

4. Select the ‘For Template Printout’ checkbox located in the upper right. 

5. In the Export Fields folder list, expand the folder for each category in your form and select 
the questions that you want to export to the PDF. 

http://help.crediblebh.com/crediblehelp/page.aspx?pageid=build_the_form_export�
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6. If you want to export data that was injected into the web form, expand the appropriate 
table folder and select the field. Note that this will export the complete contents of the 
injected box, which may be too large for the corresponding field in the PDF. 
 
Tip: you can export the Primary Axis I diagnosis to the template (instead of the full 
diagnosis) by selecting the Axis I field from the Clients folder. If the field is not in the folder, 
use Data Dictionary to add it to the Clients table. 
 
Tip: you can export related fields into a single field in a template. For example, to export 
the last name and first name fields into a single field, do not select the fields in the category 
folder. Instead, when you are on the Export Details screen (see step 7), copy the example 
expression “clients.first_name + ' ' + clients.last_name” and paste it in the Expression field. 
Enter a field name and click ‘Add Calculated Field’. When you edit the PDF (see step 9), 
add a field that has the same field name you entered in the export. You can also merge 
address information and include applicable commas (expression example: 
clients.address1 + ' ' + clients.address2 + ', ' + clients.city + ', ' + clients.state + ' ' + 
clients.zip). 

7. Click ‘Next Step’. The Export Details screen displays. It lists the fields and form questions 
you selected. You can mouse over each column header to display a tooltip. 

– The Column Order isn’t significant because the order of the questions is set in the PDF 
template. However, if you are working with a large template, you may find it easier to 
troubleshoot errors when the order of the questions in the export and PDF is the same. 

– The Export Name for each selected form question is based on the text in the Question 
field in the web form. The Export Tool limits the export name to 30 characters and 
makes a few changes such as replacing spaces with underscores, dropping special 
characters, and dropping a number if it is the first character in the Question field. 
Unique export names are important to avoid confusion. For example, if you have 
similar fields like addresses for two people, use a unique letter to indicate which 
address fields belong together (Address_1A, Address_2A, City_A, State_A, and 
Zip_A and Address_1B, Address_2B, City_B, State_B, and Zip_B). Duplicate export 
names are not allowed. 

– The export name is important because you have to copy it into the corresponding field 
in the PDF template (overwriting the default field name in the PDF). For a template to 
work correctly there must be an exact match between each export name and the 
corresponding field name in the template. We don’t recommend changing an export 
name to match a field name in the PDF because whenever you create a new export for 
the form, the export name will default back to the text in the Question field (with the 
modifications made by Export Tool). 

– Column Size field is optional as are the checkboxes like Quoted Output and Preserve 
Leading 0’s. If an answer is too large for a field in the PDF, you can use the multi line 
feature in Acrobat and/or limit the number of characters allowed in the field. 

– Long Answer must be used in conjunction with the Expand Multi Choice. When the 
answer format for a question is Check Box or No Label Checkbox and Has Notes is 
selected for the answer, you need to select both Long Answer and Expand Multi 
Choice to have the notes entered (that is, the long answer) convert to the template. 
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When creating your PDF, the fields in must be named Name_of_question_1, 
Name_of_question_2, and so on for each possible answer to the question. 

If the field in the PDF only needs to be marked with a check, then the field type will be 
CHECKBOX. If it needs to be filled with the long answer (that is, the documentation 
entered in the notes field), then the field type must be TEXT BOX. 

– Expand Multi Choice is for questions that have been set up in Form Builder with a 
check box answer format. You use this format when multiple answers are valid. 

Note: if the template has separate boxes for each character of the data that will populate a 
field, it must include a text box for each character. In addition, the export must include a 
calculated field for each character box in the template. For example, if a template includes 
5 separate boxes for each digit in a zip code, you need to add 5 calculated fields to the 
export. And the Expression field for each calculated field needs to include 
“SUBSTRING(clients.zip,1,1) for Zip1 digit”, “SUBSTRING(clients.zip,2,1) for Zip2 digit”, 
and so on. 
 
You need to copy the name of the calculated field (Zip1, Zip2, and so on) into the 
corresponding zip code digit field in the template. You cannot select the actual zip code 
field as this exports the full zip code in its entirety and not each individual digit. 

8. Click ‘Finish’ to save your export. The Export List displays. Since you will need to copy the 
export names, open the export back up by clicking ‘edit’ and then click ‘Next Step’ to 
display the export names in the Export Details screen. 

• Step 2. Edit the Field Names in the PDF 

Note: if the PDF is locked for editing, unlock it as follows: 

1. Open the PDF and select Edit > Preferences > Documents (second from top in the 
Categories list). 

2. From the PDF/A View Mode dropdown, select Never and click OK. 

Use the full version of Adobe Acrobat (or other PDF software) to open the PDF you generated 
from the electronic version of the form. 

Acrobat 8 

1. Select Forms > Create a New Form. 

2. Select ‘Start with an electronic document’ and click Continue. 

3. Select ‘Use the current document’ and click Next. 

4. Select ‘Run Auto Field Detection’ and click Next. 

5. When Auto-Detection Complete displays, click Next. 

6. When Congratulations! displays, click Done. 

If a Form Return Setup: Adding Buttons popup displays, deselect the ‘Add an email button’ and ‘Add 
a print button’ checkboxes and click Finish. 
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If your PDF uses a font that is not available on your computer, a Missing Fonts popup will display. 
Click OK to accept the substitute font listed or click Change Substitute Font, select the desired 
font/font style, and click OK. 

The PDF redisplays in edit mode; fields that were auto detected are defined. If a field was not auto 
detected, you will need to add it. 

7. For each auto-detected field, enter the corresponding export name from Credible (refer to the how to 
instructions in Adobe LiveCycle Designer for the steps to edit a field). Note: we recommend that you 
make each field in the PDF read only. 

8. If Acrobat missed a field during auto detection, add it to the PDF and enter the corresponding export 
name from Credible. 

9. Once you have updated all field names in the PDF to match the export names, save the PDF. 

Acrobat 9 

1. Select Forms > Add or Edit Fields. 

2. Click ‘Yes’ when Acrobat asks if you want it to detect form fields for you. The PDF redisplays in Form 
Editing Mode; fields that were auto detected are defined. 

3. For each auto-detected field, double click the default field name and overwrite it with the 
corresponding export name from Credible. Note: we recommend that you make each field in the PDF 
read only. 

4. If Acrobat missed a field during auto detection, use the Add New Field dropdown to define it and then 
overwrite the default field name with the corresponding export name from Credible. 

5. Once you have updated all field names in the PDF to match the export names, save the PDF. 

Acrobat 10 

1. Select View > Tools > Forms or select Tools on the toolbar and then select Forms. 

2. Select Create (equivalent to the wizard in earlier versions of Adobe Acrobat). 

a. Select ‘Use an existing file’ and click Next. 

b. Select ‘Use the current document’ and click Next. The fields should be recognized by Adobe 
Acrobat. 

3. Repeat steps 3 through 5 above. 

Tips for editing fields in the PDF: 
– The font style and size that appears in the template is controlled by the PDF. In Acrobat, 

you can change these by right-clicking on the field, selecting ‘Properties’, and going to 
the ‘Appearance’ tab. There you will find options for changing the style and size. 

– When adding a checkbox field, the default checkbox style is Check (a checkmark). You 
can change it to another style if you prefer. 

– If the box for the field on the PDF is on top of existing text/pictures in the PDF, you may 
need to move it or else the data will appear overlaid. Also you can make minor edits of 
the PDF using the TouchUp Text Tool (Tools > Advanced Editing) 

– If the PDF you are using as a template contains existing data in a field (for example, a 
client name), use the Form Wizard to select field properties/Appearance tab/Color and 
select white for the background. 
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• Step 3. Add Signature Fields to the PDF 

To inject or automatically fill in signatures into a template, add text fields to the PDF with the 
appropriate signature field names: empsig for the employee’s signature, supervisorsig for the 
supervisor’s signature, and clientsig for the client’s signature. Do not use the Digital Signature 
field (Acrobat 9). For additional signature boxes, use sig# as the field name where # is 3 - 12. 
Save the PDF after adding the signature fields. You don’t need to make any changes to the 
web form or export. 

Notes: 

– If additional signatures are needed for other individuals, add the number of signatures 
needed to the visit type associated with the web form (Admin tab > Visit Type > Visit Sigs 
field) Any labels entered in Partner Config (the Signature Box Labels) have no impact on 
the naming convention, nor will the labels be part of the exported signature. 

– Note that the Signature Box labels only affect Client forms. In an Employee form, the 
labels for signature boxes 3 and 4 will always be “Signature 3” and “Signature 4.” 

An employee can sign a visit on the Sign & Submit page using a signature pad or tablet/mouse 
or have the system use his or her saved signature (entered with the Signature function on the 
Employee nav bar). The actual employee signature is injected into the corresponding field in 
the template when the employee enters his or her password when signing/submitting the visit. 

A supervisor needs to save his or her signature (using the Signature function) and have Can 
Supervise = Yes in his or her employee profile. The actual supervisor signature is injected 
when the supervisor approves the signed/submitted visit. 

The actual client and other signatures (signatures 3 to 12) are injected when the client and 
other individuals sign the visit in the corresponding signature boxes. 

• Step 4. Upload the PDF template into Credible 

1. Find your form export in the export list and click ‘Upload’. 

2. In the Upload screen, browse for your PDF template, select PDF as the file type, and click 
‘Upload File Now’. The Export List screen redisplays. 

Note that there isn’t any versioning for templates – forms will always use the current template. 
For this reason, if you need to update a template, you should consider creating a new version 
of the web form as well. This way, existing documentation using the old form will continue to 
use the original template while new documentation will use the new template. If you update a 
template without changing the form to correspond, there may be disconnects between the 
data entered in the form and the fields in the PDF when a user prints in template mode. 
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